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3. Install({V A=) &) 97 L TTEEZWY,
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5.1. AVR128DB48 Curiosity NanoT® Atmel Studio
BRI ESEH
- A AM=NERT=Atmel Studio 7.0.2397 F7213F U LARERK

s HHIGATLT Ny TR S LB FAR O USBaf /4% 1 TAtmel Studio 7.01Z456: X 7= AVR128DB48 Curiosity NanoJ&Ak, Fvh
ITUSBIZ X > THREII, fLAIA BT Ny N I ZUSBRRHE COEXIAILET Ny L ET,

EEDRN
1. Atmel Studio 7.0&BA#ARL T/EEWY,
2. AVR128DB48 Curiosity Nano”3Atmel Studio 7.01ZBEESIVDIFIC F TORSNDEDNHENET,
[X]5-1. Atmel Studio CMDAVR128DB48 Curiosity Nano &

MCU board L.
AVR128DB48 Curiosity Nano AVR128DB48 Curiosity Nano

Extension

The Microchip AVR128DB48 Curiosity Nano evalutation kit is a
hardware platform to evaluate microcontrollers in the AVR DB family.
The evaluation kit comes with a fully integrated programmer and
debugger that provides seamless integration with Microchip MPLAB X
and Atmel Studio. The kit provides access to the features of the
AVR128DB48 enabling easy integration of the device in a custom
design. The kit features variable voltage, a virtual serial port, and a DGI
interface for easy development and debugging.

AlS Atmel START example projects using this board...
MNew Atmel START project using this beard...
MNew Atmel START project using the device on this beoard...

- Launch Data Visualizer

External Links:

@ Kit Home Page
T AVR128DBA48 Curiosity Manc Schematics
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3. ®5-2. TRENDHINIT, NewHH)=Project...(7 0y 2/ N &Iy 357>, F721ECrl+Shift+Nyva—Miy b WA Z S k> THr L
W7mY =) OVERLZ BRARL TKTEE W,

X5-2. Atmel StudioTOHHIR7 B 1IMERK

E GETTING_STARTED - AtmelStudio (Administrator)

File | Edit View VAssistX ASF Project Build Debug Tools Window Help
New » | i3 Project.. Ctrl+Shift+N |
Open * | * File... Ctrl+N
Add » Atmel Start Configurator
Close Atmel Start Example Project

E3  Close Solution &) Example Project... Ctrl+Shift+E
Import 4

W Save Selected ltems Ctrl+S
Save Output As...

W SaveAll Ctrl+Shift+S
Export Template...

B Page Setup...

&= Print... Ctrl+P
Recent Projects and Solutions 4

Ed  Exit Alt+F4

4. [H5-3. T/RrENDHEHIT, GCC C Executable Project(GCC CEATRIHE7 BY =/ N E N, IR E7 vy 27 b4 Bii(Solution nam
(-4 ) EName(7 0 =/ M) 2 (il 21X . GETTING_STARTEDELED TOGGLEE) A ST L TOKZEZ v/ L TLIZE VY,

X5-3. $73R7° 09 19 44—~

New Project B
b Recent Sort by: Default .| & = Search Installed Templates (Ctrl+E) P~
4 Installed .
GCC C ASF Board Project C/Cr+ Type: C/Ce+
C/C++ Creates an AVR 8-bit or AVR/ARM 32-bit C
Assembler GCC C Executable Project C/C++ project
AtmelStudio Solution
GCC C Static Library Project C/Cs+
GCC C++ Executable Project C/C++ *nclg, ~
Wrlio.py
v ey
GCC C++ Static Library Project C/C++ { ‘."['C:'a)
_ .:‘l'nn-r "
Create project from Arduino sketch C/C++ 4o
Name: LED_TOGGLE
Location: C:\MyAtmelStudioProjects v | Browse... I
Solution: Create new solution -
Solution name: GETTING_STARTED Create directory for solution
| Concel
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5. ®5-4. TAVRI28DB48ZE Y, OKZ/Jy/L TIIZEY,
R5-4. TNARERIY -

Device Selection >
Device Family: AVR-Dx - AVR123DB
Name App./Boot Memary (Kbytes)Data Memory (bytes) EEPROM (bytes) Device Info:
AVR128DB28 128 16384 512 Device Name: AVR128D
AVR128DB32 128 16384 512 Speed: A
AVR12B8DB4S 128 163584 512
AVR128DE64 128 16384 512 Ve WA
N Family: AVR-Dx
Device page for AVR128DB43
Datasheet

Supported Tools
» Atmel-ICE

X EDBG

X EDBG MSD
£ JTAGICES
Ml mEDBG

A Power Debugger
e MPLAE® PICkit 4

FAUTBIEL 7=main.c77AVE RO HH 7 00 /b3 Atmel Studio TARRSILET
6. LLFOa—NWr i Cmain.c 77/ VA E Lz TIIZEN,

int main (void)

{
/% SW0Z AN T1EL CHERGR TE */
PORTB. DIRCLR = PIN2_bm;

/% LEDOt™V 7% H 1L THERRER & */
PORTB. DIRSET = PIN3_bm;

/% SWOIZTL CTHER7 ATy 7 ZFF Al */
PORTB. PIN2CTRL |= PORT_PULLUPEN_bm;

while (1)
{
/% SWODARTEFHA */
/% 0: i *x/
if (! (PORTB. IN & (PIN2_bm)))
{
/% LED0ZON 3/
PORTB. OUTSET = PIN3_bm;
}
/*x 1: Bl */
else
{
/* LEDO%OFF */
PORTB. OUTCLR = PIN3_bm;
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a—N =7 UATCIEa—-N A E5-5. TRENASIIITHNDTLEY,
®5-5. 3N I74% 940

GecApplication2 - main.c

- :I-) chusers\ma4000\Documents\Atmel Studio\7.00GecApplication2\GecApplication2\main.c '|§":'G0
1 #include <avr/io.h> +
2 s
3 Elint main(void)
4 |1
5 /* Configure SW@ as input */
6 PORTB.DIRCLR = PIN2_bm;
7 /* Configure LED® pin as output */
8 PORTB.DIRSET = PIN3_bm;
9 /* Enable the internal pull-up for SW@ */
18 PORTB.PIN2CTRL |= PORT_PULLUPEN_ bm;
11
12 while (1)
13 {
14 /* Check the status of SWB */
15 /* @: Pressed */
16 if (!(PORTB.IN & (PIN2_bm))) L]
17 {
18 /* LED® on */
19 PORTB.OUTSET = PIN3_bm;
28 h
21 /* 1: Released */
22 else
23 {
24 /* LEDB@ off */
25 PORTB.OUTCLR = PIN3_bm;
26 }
27 T
28 |}
29 |

-
121% -

7. Project(7'ny x7N)=Properties(FE) &7y 73575, FT2IZAUHETYa— My b lid Z L2 Lo Ty 2/ M 2 B TLIZE W,
8. V= 4N T(R5-6. 2T ELTTEY, ), Selected debugger/programmerGEIXILIZT Nyl /EXIAZES)EZnEDBGIZ, Interface({

V=7 2=2)ZUPDUIRR EL TN,
X|5-6. AVR128DB48F DT Nyl &4 V4—71—A
& GETTING_STARTED

LED_TOGGLE + X

Build Y A
Build Events
Toolct
) Selected debugger.ferogrammer
Device
2 nEDBG - MCHP3280011800000013 - Interface: | UPDI ~

Packs
Advanced

UPDI Clock

750 kHz
Programming settings
Erase entire chip ~
W1 Preserve EEPROM
Debug settings
] Cache all flash memory except
© 2018 Microchip Technology Inc. I AR DS00003634B - 10E
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9. Build45)=Build Solution(FER R EREL)Z /)y ) T 20, FTIFFTVa— My el ZEIC LTI ey 2/ ML TLIZE,

10. 7’03 =7 hDa—R 2 AVR128DB48IZ E XA A TDebug(7 /" 'v/)=Start debugging and break(7 '/ BltREF W Z 7)) 450, £
TAXAIHES Y a— iy M EH Z L2 > T Ay ZBRIAL CTLCLIEEWN I HRT A AAZE T 07 703 T2 main OB % ¢
Wr42CLxo,

11. Debug(7 ' /~'v7)= Countinue({e) &7V v/ 350, FI21ZF5va—My ) Z L2 Lo Ta— N 2L TEEW,

12. AVR128DB48 Curiosity Nano_ETSWOR IS ILHREIZILEDOZS sk 9752 L2 R L TLTE &Y,

6. MPLAB® X{#E & DERIRIZIRLT

6.1. AVR128DB48 Curiosity Nano TOMPLAB® X
EALESEH
« AVAMAEITZMPLAB X

« FHIIALT Ny NI S A FE O USBaR /48 I TMPLAB XIZHEE X472 AVR128DB48 Curiosity Nano#s#k, ¥vMIUSB
ICE o THREIN FIIABLT Ny ITUSBRE TOEXIALLT Ny L E 1,

EEDTN
1. MPLAB XZBZEL T7ZS0,
2. ®6-1. T/REND EIZAVRI28DB48 Curiosity NanoASMPLAB XIZ#E#i S VAR IC B E T,
X6-1. MPLAB® X TMAVR128DB48 Curiosity Nano &

MCU Boards AVR128DB48 Curiosity Nano

& AVR128DE48 Curiosity Nano

The Microchip AVR128DE48 Curiosity Nano evalutation kit is a hardware platform to
evaluate microcontrollers in the AVR DB family. The evaluation kit comes with a fully
integrated programmer and debugger that provides seamless integration with
Microchip MPLAE X and Atmel Studio. The kit provides access to the features of the
AVR128DB48 enabling easy integration of the device in a custom design. The kit
features variable voltage, a virtual serial port, and a DGl interface for easy development

and debugging.

¥ External Links

@ kit Home Page
» Extension @« e

T AVR128DB42 Curiosity Nano Schematics

» Kit Information

¥ Design Files

@ Cpen Altium praject in Browser

T Download Altium project

AVRI128DB48 Curiosity Nano Schematics

© 2018 Microchip Technology Inc. [ FER R DS00003634B - 11
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3. [6-2. T/RENAH LT, File(Z74V)=New Project...CIHR7 2y 2/ NE /Y979 20>, 721X Ctrl+Shift+NYa—Miv a5 2 Sz ko
THLNT By =/ OVEREBIARL TTZE VY,

6-2. MPLAB® XTO#F#R7' 0y 1IMERK
File Edit View Navigate Source Refactor Production Debug Team Tools Window Help

| MNew Project... Ctrl+Shift+N T B PR -UOB-
1 Mew File.. Ctrl+N
=
Open Project... Ctrl+Shift+0
Open Recent Project >
Import by

Close Project

Close Other Projects

Close All Projects

Open File...

Open Recent File >

Project Groups...
Project Properties

Save Ctrl+5S

Save As...

Save Al Ctrl+Shift+5
Page Setup...

Print... Ctrl+Alt+Shift+P

Print to HTML...

Exit

4. X6-3.7 b Categories(X4y) TMicrochip Embedded(Microchipfl#xiA %)% | Projects(7 Y/ /b CStandalone Project(JRANZHI 70
V) MEI &% A CNext(IR~) %7y 7L TLTZEW,

B6-3. FE7 0 19 94U

! New Project

Steps Choose Project
1. Choose Project Q, Filter:
2. ..
Categories: Frojects:
P/ @l Microchip Embedded (&) Standalone Project
I3 Other Embedded (& Existing MPLAB IDE v8 Project
- Samples {& Prebuilt (Hex, Loadable Image) Project

f) User Makefile Project

& Library Project

5 Import START MPLAB Project
& Import Atmel Studio Project

Description:

Creates a new standalone application project. It uses an IDE-generated makefile to
build your project.

< Back Finish Cancel Help

© 2018 Microchip Technology Inc. [ FER R DS00003634B - 12
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5. AVR128DB48(®|6-4.2 /) Z &N, Next(R~)%E7)y/ L TLTEEN,
X6-4. T NAAEIRY4ULT)

ﬂ Mew Project bt
Steps Select Device
1. Choose Project
2. Select Device
3. Select Header Family: All Families i
4, Select Plugin Board
5. Select Compiler )
6. Select Project Name and barzz AVR 12808
Folder Filtering All Elements:
Tool: AVR128DB28 [] Show All
AVR1280B32
AVR128DB43
AVR128DB64

< Back MNext = Finish Cancel Help

HLDHDIRD, ZDHIZHMEHE TN AT 218 A TS,

6. Project Name(7 v/ 2/ M4 ) (il 21X, LED_TOGLE)&Project Location(7 2y =/ M) (i 21X . C¥microchip)z A 77 L CFinish(#
TY&EI)yILTLIZEN,

X6-5. 7’0V 19M B EGLiEEIRD4UF D

! New Project

Steps Select Project Name and Folder

Choose Project

Select Device Project Name: LED_TOGGLE

Select Header

Select Tool (Optional) Project Location: C:\microchip Browse...
Select Plugin Board

Select Compiler Project Folder: C:\microchip\LED_TOGGLE.X

Select Project Name

and Folder

bl L

Overwrite existing project.
Also delete sources.
Set as main project
[ ] use project location as the project folder

vl Encoding: [50-8859-1 -

< Back Next = Cancel Help

© 2018 Microchip Technology Inc. [ FER R DS00003634B - 138
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7. ®6-6. T/RSNDHIIIT, File(Z7AV)=New File... (B 774M%&) ) $ 27 F2ZCtrl+Nva- My affd Z &2 &> Tmain.c774

MaAERL L TLIZEW,

X6-6. MPLAB® X CEiR77 /I {ER

1 New Project..
¥ New File...

Open Project...
Open Recent Project

Import

Close Other Projects
Close All Projects
Open File...

Open Recent File

Project Groups...

Save
Save As...
Save Al

Page Setup...
Print...
Print to HTML...

Exit

Ctrl+5Shift+MN
Ctrl+N

Ctrl+Shift+0

Close Project (LED_TOGGLE)

Project Properties (LED_TOGGLE)

Ctrl+S

Ctrl+Shift+5

Ctrl+Alt+Shift+P

File Edit View MNavigate Source Refactor Production Debug Team Tools Window Help

"B DR QB @

1

8. ®6-7.CCategories(X47) TC% . File Types(77ANEF) TC Main File(CE774W)Z N, Next@R~%7)vI L TLTZEUY,

X6-7. FTFRI7AN 1408

3 New File

Steps

Choose File Type

1. Choose File Type
2. ..

Project: [5G LED_TOGGLE

Q, Filter:

Categories:

File Types:

- Microchip Embedded

----- =) Assembler
----- =) shell Scripts
---- =) Makefiles

E] C Source File
] C Main File
E| C Header File

Description:

A C file with a main() function that includes the stdio and stdlib header files.

Finish Cancel Help

© 2018 Microchip Technology Inc.
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9. 774N (B 21X main)& A JJL CFinish(#& 17)%& 7097 TLIEEWY,
X6-8. 774 & 4N

%' New C Main File

Steps Name and Location

1. Choose File Type File Name: 'main
2. Name and Location
Extension: ¢ ™

Set this Extension as Default

Project: LED_TOGGLE

Folder: Browse...

Created File: | C:\microchip\LED_TOGGLE.X\main.c

< Back Next = Cancel Help

10. LL F@a—NW A Cmain.c77AVE B E#L 2 TR S0,

int main (void)

{

/% SW0Z AN T1EL CHERGR E */
PORTB. DIRCLR = PIN2_bm;

/% LEDOt™V 7% H 1L THERRER E */
PORTB. DIRSET = PIN3_bm;

/% SWOIZKF LU CNFER7 AT v 7 37 Rl %/
PORTB. PIN2CTRL |= PORT_PULLUPEN_bm;

while (1)
{
/% SWODARTEFHA */
/% 0: i %/
if (! (PORTB. IN & (PIN2_bm)))
{
/% LED0ZON 3/
PORTB. OUTSET = PIN3_bm;
}
/% 1: Bl */
else
{
/* LEDO%OFF */
PORTB. OUTCLR = PIN3_bm;

© 2018 Microchip Technology Inc. [ FER R DS00003634B - 15
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main.c CHinclude<avr/io.h>ZBINL TLIZEWY, 2—F 2742 TIERI6-9. TREND IR BEN D TL LI,
E6-9. 3-F IT7 14 94Uk
B4 main.c - Editor - O X

13 main.c x| |IE|E]@

Source | History | B0 QTHF | F &R e o UL 550 ;2

i
>
u

n

#include <avr/io.h>

int main (wvodid)
Bt

PORTB.DIRCLR = PIN2Z bm;

LTSI C RS - L S T

PORTE.DIRSET = PIN3_bm;

—
=
=

=
=
[a]
(=]
s
-
(5]

.PINZCTREL |= PORT_PULLUPEN bm;

=
W
)
o
=
-
m

(1)

=
(DR
-

!

=
(=1
1

T

T

if (!(PORTB.IN & (PINZ bm)))
{

= o
m -

=
w

PORTE.OQUTSET = PIN3 bm:

[T A
[l =1
L

[ T oS R oS ]
LT TER 8 ]
L
=
4]
Mmoo
]
T
[
1
!

]
o

[
o

PORTE.OUTCLE = PIN3_ bm;

[ ]
(LU |

[
w

ao | v

E]} @ main 3 x

30:1 [ms]

11. Production(fF)=Clean and Build Main Project(fB¥S L CE7 0y 2/ Mt 2y /4 5h £721EShift+F 1 1va—Mybefdis s
WZEo Ta—NEREEEL TEENY,

12. 7°2 2/ bDa—N 2 AVR128DB48IZ EEIA A TDebug(7 Ny )=Debugging Main Project(F=7"2 z/b T NI )& )9 ) A2 81T
o TF NI 2RI L TLTLIZENY,

13. AVR128DB48 Curiosity Nano_ECTSWOR RS IULDRFIZLEDOZS sk 9752 L& fERE L TLTE &V,

7. RIEAA1?

B9 2AVRIL L EIDED B2 D1 HUC OV TUL TV /A2 SR TIZS0,

Y7b917:

+ Atmel Studio

+ Atmel Studio~V7’ : “Help(~Vv7)=View Help(MV7° % oR)” (Va—Miy b Ctrl+F1”)

+ Microchip B/r=

+ MPLAB X

« AVRHIAR Embedded Workbench : www.iar.com/iar-embedded-workbench/#!?architecture=AVR

77—L"9IT:

- Atmel START 33

- Atmel START

« GitHubfl

N=F"17:

- AVR042:AVR®< (/1 av/bn—7 n—=KyT %Gt D552
- AVR IBIS774 )V

- AVR BDSL774v

© 2018 Microchip Technology Inc. [ FER R DS00003634B - 16 E
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HRINDGEEZAH/TNYY U=

« Atmel-ICE:
- fEHEDOFFX
N

+ Power Debugger:
- fEHEDOTFIIX
- A

+ MPLAB Snap:
N

+ MPLAB PICKkit® 4:
- A

Z D th:

+ AVR Freaks® : www.avrfreaks.net/

« I ERIR : www.microchip.com/paramChartSearch/chart.aspx?branchID=30047, Lip7T N A 2% A CTHRLF EIZIT o TLIEE Y,
BE 4 A2 o Rl X DocumentationSLE)F 7 F TR OITAZENTEE T,

« AVRELFLEIRER © www.microchip.com/paramChartSearch/chart.aspx?branchID=30047

« K& 7B EE T A0 2L OFEMT CE ¢ https://www.microchip.com/webdoc

« MicrchipF i34 : www.microchip.com/support/hottopics.aspx

8. WETIERE
XEWET B 1 AR
A 20204F9 A HIR ST A B
B 902049 Bt L it o F 51BN ETAN3636 — MVIO 22 ELEIREL TOWNHEFOPAMP
OER x5 2Y ) TCOBFEE E
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